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Introduction to RealPlayer Plus
5.0

Welcome to RealPlayer Plus 5.0 by RealNetworks. RealPlayer Plus gives
you quality “one-button” access to the news and entertainment that you want.

Using RealPlayer Plus, you can listen to and view thousands of hours of live
and pre-recorded clips, including sporting events, live radio stations, news,
music, and lectures. RealPlayer Plus allows you to quickly and easily preset
your favorite channels, scan for new stations, and enhance your control by
getting better audio and video quality.

If you have not already installed RealPlayer Plus, please do so now. The
installation takes just a couple of minutes. Installation instructions start on
page 4.

For more information, refer to our Web site: http://www.real.com.
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About this Manual

This documentation provides instructions for the installation, operation, and
customization of RealPlayer Plus. It assumes that you have a basic knowledge
of your operating system and your World Wide Web browser, such as
Netscape Navigator or Microsoft Internet Explorer.

Documentation Conventions

The following conventions are used in this manual:

Bold text indicates the names of commands you should select and buttons you
should click.

Italic text indicates a URL (Internet address) you can access through your
browser.

Monotype text indicates messages that appear on your computer screen.

SMALL CAPS text indicates a button on your keyboard.

Other Resources

For the latest information on our products, visit the RealNetworks’ home
page at:

http://www.real.com

Player Plus specific information, a technical knowledge base, a frequently
asked questions list, and a technical library are available from the PlusZone at:

http://pluszone.real.com/

Please refer to the enclosed Technical Support Card for more information on
contacting RealNetworks Technical Support.
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RealPlayer Plus Components

In addition to RealPlayer Plus, several different special-purpose RealPlayer
Plus components are installed on your computer. The components work with
different elements within World Wide Web pages to deliver sound and video
in a variety of ways. The RealPlayer Plus components are:

RealPlayer Plug-in The Plug-in provides access to RealMedia
programming and extends the audio and video
capabilities of your Netscape Navigator browser 2.0 or
later or Microsoft Internet Explorer browser 2.0 or
later.

RealPlayer Plus
Control for ActiveX

The RealPlayer Control provides access to RealMedia
programming and extends the audio and video
capabilities of your Microsoft Internet Explorer
browser and other applications that support embedded
ActiveX controls.

RealAudio Xtra for
Shockwave

The RealAudio Xtra for Shockwave provides
RealAudio programming within a Macromedia
Shockwave movie.
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Installing RealPlayer Plus

It is strongly recommended that you use at least a 28.8 Kbps modem with
RealPlayer Plus. A 14.4 Kbps modem limits your ability to access much of the
higher-quality RealMedia content.

You can improve the playback quality of some content by enabling the
PerfectPlay mode. Refer to “Playing Clips in PerfectPlay Mode” on page 27
for more information.

Windows 95 and Windows NT

System and hardware requirements:

• Windows 95 or Windows NT 3.51 or later

• CPU:

 Audio: 486 DX / 66 MHz minimum

 Video: Pentium / 75 MHz minimum

• RAM Requirements:

 Audio: at least 8 MB recommended

 Video: at least 16 MB recommended

• Minimum of 2 MB of free hard-disk space

• CD-ROM drive

• 14.4 Kbps modem (28.8 Kbps or faster connection for playing video)

• Web browser and Internet connection

When you insert the RealPlayer Plus CD-ROM into your CD-ROM drive, the
installation starts automatically.
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RealPlayer Plus is installed in the C:\REAL\PLAYPLUS directory, unless you
specify otherwise. The installation also installs several system files into the
C:\WINDOWS\SYSTEM directory of your hard drive.

Note: For a complete list of the files that are installed, refer to the readme.htm
file found in the C:\REAL\PLAYPLUS directory after the player is installed.

If the installation does not start automatically, perform the following steps:

To manually install RealPlayer Plus:

1. Close any open applications or programs in Windows.

2. Insert the CD-ROM into your CD-ROM drive.

3. Click Run on the Start menu.

4. Enter CD Drive:\setup.exe and click the OK button. (For example:
D:\setup.exe)  The RealPlayer Plus installation begins. Follow the
instructions in each of the screens that follow.

5. When the installation is complete, you receive a message about visiting
the PlusZone, the exclusive web site for RealPlayer Plus users. For more
information refer to “PlusZone” on page 10.

When the installation is complete, a shortcut for RealPlayer Plus is added to
your Windows 95 or Windows NT desktop, and a RealPlayer Plus icon is
added to your system tray.
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Windows 3.1 and Windows 95 (using 16-bit
Winsock)

System and hardware requirements:

• Windows 3.1 or later or Windows 95 (using 16-bit Winsock)

• A Windows-compatible sound card is recommended (but not required)

• CPU:

 Audio: 486 DX / 66 MHz minimum

 Video: Pentium / 75 MHz minimum

• RAM Requirements:

 Audio: at least 8 MB recommended

 Video: at least 16 MB recommended

• Minimum of 2 MB of free hard-disk space

• CD-ROM drive

• 14.4 Kbps modem (28.8 Kbps or faster connection for playing video)

• Web browser and Internet connection

• Windows display set to at least 256 colors

• Video for Windows 1.1.e installed for video playback (Windows 3.1 only).
The RealPlayer Plus searches for Video for Windows during installation.
If it is not found, you may download the Video For Windows package
from Microsoft’s web site (http://www.microsoft.com).

RealPlayer Plus is installed in the C:\REAL\PLAYPLUS directory, unless you
specify otherwise. The installation also installs several system files into the
C:\WINDOWS\SYSTEM directory of your hard drive.

Note: For a complete list of the files that are installed, refer to the readme.htm
file found in the C:\REAL\PLAYPLUS directory after the player is installed.
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To install RealPlayer Plus:

1. Close any open applications or programs in Windows.

2. Insert the CD-ROM into your CD-ROM drive.

3. Click Run from the Program Manager File menu in Windows 3.1 or from
the Start menu in Windows 95.

4. Enter CD Drive:\setup.exe and click the OK button. (For example:
D:\setup.exe)  The RealPlayer Plus installation begins. Follow the
instructions in each of the screens that follow.

5. When the installation is complete, you receive a message about visiting
the PlusZone, the exclusive web site for RealPlayer Plus users. For more
information refer to “PlusZone” on page 10.

When the installation is complete, a RealPlayer group is added to your
Windows 3.1 Program Manager or Windows 95 Programs menu.
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Macintosh

System and hardware requirements:

• Macintosh PowerPC

• RAM Requirements:

 Audio: at least 8 MB recommended

 Video: at least 16 MB recommended

• Minimum of 2 MB of free hard-disk space

• CD-ROM drive

• 14.4 Kbps modem (28.8 Kbps or faster connection for playing video)

• Web browser and Internet connection

RealPlayer Plus is installed in the RealPlayer Plus folder on the Desktop,
unless you specify otherwise. The RealPlayer Plus installation also installs
several files into the System Folder of your computer.

Note: For a complete list of the files that are installed, refer to the ReadMe file
found in the RealPlayer Plus folder after the player is installed.
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To install RealPlayer Plus:

1. Close any open applications or programs.

2. Insert the CD-ROM into your CD-ROM drive.

3. Double-click the RealPlayer Plus CD-ROM icon.

4. Double-click RealPlayer Plus Installer. The RealPlayer Plus installation
begins. Follow the instructions in each of the screens that follow.

5. When the installation is complete, you receive a message about visiting
the PlusZone, the exclusive web site for RealPlayer Plus users. For more
information refer to “PlusZone” on page 10.
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PlusZone

A one-stop, centralized Web site for product information, online offers, and
premium content, the PlusZone lets Plus customers learn about the product and
find out about cool offers.

When RealPlayer Plus is successfully installed, the following message appears:

Figure 1: Visit PlusZone message

To visit the PlusZone:

• Click the  button. Your default World Wide Web browser opens
and welcomes you to the PlusZone. From here you can visit the PlusZone
Web site where you view special online offers for RealPlayer Plus
customers, get your RealPlayer Plus questions answered, and view the
RealPlayer Plus tutorial.

 If you choose not to visit the PlusZone at this time, this message reappears
the next time you open RealPlayer Plus. This enables you to visit at a later
time. If you want to disable this message, check the Please don’t show
this message again box. If you want to access the PlusZone at a later
time, you can do so by clicking the customize your PlusZone page link
on the ReadMe.htm file in the same directory as the Player.

Note: If you upgrade or change your World Wide Web browser, open the
ReadMe.htm file with your new browser and click the customize your
PlusZone page link.
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Overview of RealPlayer Plus

RealPlayer Plus enables you to listen and view files over the Internet or over a
local area network in real-time, without downloading them to your hard drive.
When you click a RealMedia link on a World Wide Web page, your
RealPlayer Plus automatically opens and plays the file you have selected. In
addition, you can pause, rewind, fast-forward, stop, and start the clip at the
click of a button.

Mute Button

Volume Control

Scan Button

Link to
Real Networks
Home Page

Preset Buttons

    Title, Author,
Copyright text

         Status Bar

Fast Forward /
Rewind Buttons

Position SliderStop Button

Play /
Pause Button

       Selective Record Button

           Image Area

 Stereo Indicator Zoom Button

Destination Buttons

Compact Button

Figure 2: Overview of RealPlayer Plus for Windows 95 and NT
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Section Description

Play/Pause Button Click the  button to play or pause a clip,
depending on the status of the clip.

Record Button Click the  button to record the clip
currently being played.

Note: Content providers control whether or not
you may record a clip.

Stop Button Click the  button to stop the clip.

Position Slider The slider moves as a clip is being played. You
can fast forward or rewind to a different
section of the clip by dragging the slider.

Fast Forward/Rewind
Buttons

Click the  button to fast forward the clip or

the  button to rewind the clip.

Link to the
RealNetworks Home
Page

If you are connected to the Internet, click the

 button to link to the RealNetworks
Home Page.

Image Window If you are playing a video clip, the image
appears in this window.

Preset Buttons You can set these buttons to automatically link
to a specific site and play a RealMedia clip.
The URL location and the label of the Preset
buttons are customized on the Preset tab of the
Preferences window. You can also set a Preset
button to the current clip by clicking with the
right mouse button (Windows) or clicking and
holding (Macintosh) the Preset button, then
selecting Set Preset to (current clip).
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Section Description

Scan Button The  button allows you to scan available
content, similar to scanning stations on your
car radio. For additional selections, click with
the right mouse button (Windows) or click and
hold (Macintosh) the Scan button, a pop-up
menu appears from which you can select to
scan sports, news or music stations, or to scan
your presets.

Destination Buttons Click these buttons to go to the Destination
web site where you can select premium
content. The buttons are programmed to the
content you select.

Title, Author and
Copyright Text

The content provider specifies the text in these
fields; they normally describe the clip being
played.

Volume Control The volume control indicates the volume at
which the clip is being played. Increase the
volume by dragging the control up, and
decrease the volume by dragging the control
down.

Note: If your RealPlayer Plus does not have a
volume control slider, it is because your sound
card does not allow the Player to adjust the
volume.

Mute Button
Click the  button to silence the audio
portion of the clip. The clip continues to play.
Click this button again to hear the audio
portion of the clip.

Status Bar The status bar displays information about the
player and the clip.

For more information, refer to “Status Bar
Icons” on page 15.
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Section Description

00:00.0/00:00.0 The elapsed time (the length of time that the
clip has been playing) and the total time (the
length of the entire clip).

Note: When playing a live stream, Total Time
value is replaced by the word live.

Status This is a one-line informational display that
gives the current status of the Player, explains
menu options, and displays the assigned URL
for each Preset button. For example: Playing
19 Kbps local file.

Zoom Button
Click the  button to open a menu where
you can choose to double the video image area,
enlarge the image area to full screen (Windows
95 and NT only), or return the image area to
original size.

Note: If you are running RealPlayer on
Windows 3.1 or Macintosh, simply click the

 button to double the image area. Click this
button again to return the image area to the
original size.

Compact Controls
Button

Click the  button to display a subset of the

buttons. Click the  button to display all of
the controls.
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Status Bar Icons

Section Description

Indicates the clip currently being played is
in stereo.

Indicates the clip currently being played is
in mono.

Green lightning bolt indicates some loss of
playback quality due to quality of connection.

Red lightning bolt indicates poor playback
quality due to quality of connection.

Indicates that RealPlayer Plus is buffering the
stream.

Indicates that the network is busy and the
player is buffering more data.

Indicates that RealPlayer Plus is recording the
current file.

Indicates that the current file cannot be
recorded.
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RealPlayer Plus Menus

RealPlayer Plus has five menus: File, View, Clip, Sites, and Help. These
menus allow you to take full advantage of RealPlayer Plus features.

File Menu

Commands from the File menu allow you to play RealMedia files without
using your World Wide Web browser to find files on the Internet, to enable
PerfectPlay mode, and to exit RealPlayer Plus.

Figure 3: File menu

Menu Option Description

Open Location… Select this option to play RealMedia files
through the Internet without using your World
Wide Web browser. The Open Location dialog
appears, enter the URL (Internet address) of an
.ra, .rm, or .ram file.

Open File… Select this option to play a local RealMedia file.
When the Open File dialog appears, select an .ra,
.rm, or .ram file stored on your computer.
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Menu Option Description

Open Recent Select this option to view a list of recently
played clips. You can select a clip from this list
to play the clip again.

PerfectPlay Mode Select this option to switch to PerfectPlay mode;
a check mark appears next to the option. This
mode enables you to improve the playback
quality by increasing the amount of the clip that
is buffered. The time it takes to buffer the clip
will be slightly longer, but sound quality,
especially with 14.4 and 28.8 Kbps modems,
should be improved. To return to Regular mode,
select this option again; the check mark is
removed.

You cannot use PerfectPlay mode with a
live stream.

Close Window
(Macintosh only)

Select this option to close a secondary window,
such as the Connections Statistics window.

Exit/Quit Select this option to exit RealPlayer Plus.
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View Menu

Commands from the View menu allow you to control the appearance, to set
user preferences, and view the performance of RealPlayer Plus.

Figure 4: View menu

Menu Option Description

Normal Select this option to display all buttons and
controls; a mark appears next to the option.

Compact Select this option to display only the image area
(if playing a RealVideo or Flash clip), a subset of
the buttons and a reduced Status bar.

Auto-Size Select this option to display only the image area
(if playing a RealVideo or Flash clip) when the
cursor is not over the RealPlayer Plus window; a
mark appears next to the option. When the cursor
is on the window, the Compact controls are
displayed.
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Menu Option Description

Presets & Scan Select this option to display the Preset and Scan
buttons; a check mark appears next to the option.
Select the option again to hide the buttons; the
check mark is removed.

Destinations Select this option to display the Destinations; a
check mark appears next to the option. Select the
option again to hide the bar; the check mark is
removed.

Status Bar Select this option to display the Status Bar; a
check mark appears next to the option. Select the
option again to hide the bar; the check mark is
removed.

Info & Volume Select this option to display the volume control,
and the title, author, and copyright information
for the clip; a check mark appears next to the
option. Select the option again to hide the
information; the check mark is removed.

Preferences… Select this option to display the Preferences
window for configuring RealPlayer Plus. For
more information, refer to “Setting Preferences”
on page 37.

Note: This option is on the Edit menu in the
Macintosh version of RealPlayer Plus.

Statistics… Select this option to display the transmission
quality information in the Connection Statistics
dialog. The Connection Statistics dialog reports
the performance of the Internet connection
between RealServer and RealPlayer Plus. Refer
to Figure 5 for an example of the Connection
Statistics window.

You can click the  button to see
additional connection information.
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Menu Option Description

Always on Top
(Windows only)

Select this option to make RealPlayer Plus
remain on top of all other windows, even when
another window is active; a check mark appears
next to the option. Always on Top is convenient
for keeping RealPlayer Plus visible while you
interact with your World Wide Web browser.
Select this option again to allow other windows
to open on top of RealPlayer Plus; the check
mark is removed.

Figure 5: Connection Statistics window
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Clip Menu

Some RealMedia files can include several clips played one after the other.
Commands from the Clip menu allow you to move between clips in a multi-
clip RealMedia (.ram) file and when scanning. This scanning is similar to
using seek buttons on a CD player. If there is only one clip at the link you are
accessing, these options are not available.

Previous Clip and Next Clip are also available from the shortcut menu that
appears when you right-click (Windows) or click and hold (Macintosh) the
mouse button in RealPlayer Plus window.

Figure 6: Clip menu

Menu Option Description

Previous Clip Select this option to play the previous clip in a
multi-clip RealMedia (.ram) file or when
scanning.

Next Clip Select this option to play the next clip in a multi-
clip RealMedia (.ram) file or when scanning.
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Sites Menu

Commands from the Sites menu allow you to access various pages at the
RealNetworks and Timecast World Wide Web sites. This feature works with
popular World Wide Web browsers. If you are connected to the Internet, and
your World Wide Web browser is not open, RealPlayer Plus opens it for you.

Note: You must be connected to the Internet to reach these sites.

Figure 7: Sites menu

Menu Option Description

PlusZone Select this option to access the PlusZone – the
one-stop centralized web site for product
information and premium content.

Real Home Page Select this option to access the RealNetworks
Home Page.

Real Content Select these options to access sites that feature
RealMedia.

Timecast: Your
RealMedia Guide

Timecast contains a list of World Wide Web
sites providing RealMedia content.

MusicNet MusicNet contains a directory of RealMedia
happenings in the music world.
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Menu Option Description

LiveConcerts.com LiveConcerts.com is the premier site for live
music events broadcast on the Internet using
RealMedia.

Film.com Film.com provides an unprecedented collection
of material on film for a world-wide audience,
offering breadth and depth, and bringing together
critics, writers and movie buffs everywhere.

DailyBriefing.com DailyBriefing.com is where you build your own
customized video and audio daily newscast,
choosing from the best news, sports, business,
technology, entertainment, and music programs
on the Web.

Customize RealPlayer
Plus

Select these options to customize your
RealPlayer Plus content buttons.

Destinations Tutorial Select this option to access a page where you can
learn how to set your preset and destinations
buttons.

Customize Daily
Briefing

Select this option to access a page where you can
customize your Daily Briefing button.

Customize Destinations Select this option to access a page where you can
customize your destination buttons.

Customize Presets Select this option to access a page where you can
customize your preset buttons.
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Help Menu

Commands from the Help menu provide you with online help and information
about RealPlayer Plus.

The latest support and technical information is available at:

http://service.real.com

Please refer to the enclosed Technical Support Card for more information on
contacting RealNetworks Technical Support.

Figure 8: Help menu

Menu Option Description

Contents Select this option to open the online help for
RealPlayer Plus.

Note: The Macintosh version of RealPlayer Plus
does not have online help.

Online Tutorial Select this option to access the RealPlayer Plus
tutorial, which describes the major features of
the Player.
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Menu Option Description

Common Questions Select this option to access the RealNetworks
Frequently Asked Questions. You must be
connected to the Internet for this option to work.

Search Knowledge Base Select this option to access the RealNetworks
Knowledge Base. You must be connected to the
Internet for this option to work.

Service & Support Select this option to access the RealNetworks
main help page. You must be connected to the
Internet for this option to work.

Full Screen Help
(Windows 95 and NT
only)

Select this option to access RealNetworks’ Full
Screen and DirectDraw information page.

Suggestion Box Select this option to access the comments web
page where you can enter suggestions or
comments about the RealPlayer Plus.

Check for Upgrade Select this option to query the RealNetworks
web site for upgrade information. A dialog box
tells you if there is an upgrade available.

About… Select this option to display RealPlayer Plus
version and copyright information.

Note: This option is on the Apple menu in the
Macintosh version of RealPlayer Plus.
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Using RealPlayer Plus

Your RealPlayer Plus has several powerful features that allow you to make the
most of the Internet.

Starting a Clip

There are several ways to start a RealMedia clip. Do one of the following:

• Click a RealMedia link on a World Wide Web page. Your World Wide
Web browser opens RealPlayer Plus and the clip is streamed to RealPlayer
Plus immediately. After storing a few seconds of the clip (buffering), the
clip begins.

• Access a World Wide Web site or select an action (click a link, open an
html page) that automatically plays a clip. Your World Wide Web browser
opens RealPlayer Plus and the clip is streamed to RealPlayer Plus
immediately. After storing a few seconds of the clip (buffering), the clip
begins.

• Click one of the Preset buttons, or the  button on RealPlayer Plus.
The clip is streamed to RealPlayer Plus immediately. After storing a few
seconds of the clip (buffering), the clip begins.

• Click Open File or Open Location on the File menu on RealPlayer Plus.
For more information, refer to “File Menu” on page 16.
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Pausing a Clip

You can pause a clip while it is playing. If you pause a clip but do not resume
playing after several minutes, the Server may terminate your connection. The
length of time you can pause a clip without your connection terminating
depends on the particular Server.

• Click the  button. This pauses the clip. If you want to resume the

clip at the same point it was paused, click the  button.

Stopping a Clip

You can stop a clip while it is playing.

• Click the  button. The clip stops playing. To play the clip again from

the beginning, click the  button.

Playing Clips in PerfectPlay Mode

PerfectPlay mode enables you to improve the playback quality by increasing
the amount of the clip that is streamed to RealPlayer Plus before the clip
begins playing. The time it takes to buffer the clip will be slightly longer, but
playback quality, especially with 14.4 and 28.8 Kbps modems, should be
improved.

You cannot use PerfectPlay mode with a live stream.

• Select PerfectPlay Mode from the File menu. Return to Regular mode by
selecting this option again.

Note: Content providers may control whether PerfectPlay mode is
available for a specific clip.
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Muting a Clip

You can mute a clip while it is playing. The clip continues to play but does not
play the audio.

• Click the  button. To hear the audio, click the button again.

Recording a Clip

You can record your favorite RealMedia clips for later playback from your
computer. Keep in mind that not all content can be recorded. Content
Providers control whether or not you may record a clip.

Note: If you attempt to record a clip that has this feature disabled, the 
icon appears in the Status bar of RealPlayer Plus.

To start recording a clip during playback:

1. Click the  button. A Save As dialog box appears.

2. Select the filename and location on your computer where you want to save
the file.

3. Click the OK button when you have finished entering the information.
RealPlayer Plus begins recording. While RealPlayer Plus is recording, the

 icon appears in the Status Bar of RealPlayer Plus.

Some RealMedia clips are several files played one after the other. If you chose
to save a clip that is a compilation of several clips, a new Save As dialog box
appears at the beginning of each new clip.

Note: Content providers control whether or not you may record a clip. If you
attempt to record a clip that has this feature disabled, the  icon appears in
the Status bar of RealPlayer Plus.
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To set up recording a clip prior to playback:

1. Click the  button.

2. Open the clip. A Save As dialog box appears.

3. Select the filename and location on your computer where you want to save
the file.

4. Click the OK button when you have finished entering the information.
RealPlayer Plus begins recording and playing the selected clip. While the
clip is recording, the  icon appears in the Status Bar of RealPlayer
Plus.

Some RealMedia clips are several files played one after the other. If you chose
to save a clip that is a compilation of several clips, a new Save As dialog box
appears at the beginning of each new clip.

Note: Content providers control whether or not you may record a clip. If you
attempt to record a clip that has this feature disabled, the  icon appears in
the Status Bar of RealPlayer Plus.

To stop recording:

• Click the  button. RealPlayer Plus stops recording, but the clip
continues to play.

To play a clip you recorded:

1. Select Open File from the File menu.

2. Select the .ra, .rm, or .ram file you recorded. RealPlayer Plus plays the
file.
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Changing the Size of the RealPlayer Plus Window

Do one of the following:

• Click the  button to display the RealPlayer Plus in Compact view.
This view displays a subset of buttons, a smaller status bar and the image
window (if not playing an audio-only clip).

• From the View menu, select the appropriate option to modify the size of
the RealPlayer Plus window.

• Normal displays all the controls and buttons.

• Compact displays a select group of buttons:

• Auto-Size looks like Compact when playing an audio-only clip or
when the cursor is over the window. For non audio-only clips, only an
image window is displayed when the cursor is not over the window.
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If the video or RealFlash clip won’t fit on your RealPlayer screen using the
current settings, RealPlayer will ask if you would like your settings changed
automatically.

Figure 9: Change Current Settings Window

• Select Yes if you want RealPlayer to automatically change your
settings.

• Select No if you don’t want RealPlayer to automatically change your
settings.

• If you want RealPlayer to always resize in this situation, select Please
don’t ask me again, and then select Yes.

• If you don’t want RealPlayer to offer this option, select Please don’t
ask me again, and then select No.
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Changing the Size of the Image Area

You can enlarge the size of a video or RealFlash clip image to double size. In
addition, you can enlarge the size of a video clip image to full screen size
(Windows 95 and NT only). However, these features increase the processing
time required for playback. If your playback quality decreases or if your
machine seems overloaded, you should return the clip image back to original
size.

Note: In order to use the Full Screen feature, you must have Microsoft DirectX
Tools with DirectDraw, and recent video drivers, installed on your machine.
For information on downloading and installing the most recent version from
Microsoft’s web site, refer to “Troubleshooting” on page 55, or select Full
Screen Help from the RealPlayer Help menu.

Before you can use the Full Screen feature, the Player will ask you to run a
short test to see if your DirectX and video drivers are functioning properly.
The test involves switching into Full Screen mode for 5 seconds. Then, you are
asked to confirm whether you saw the RealPlayer logo in Full Screen mode. If
yes, then the Player resumes the clip, switches to Full Screen mode, and you
will not be asked to run the test in the future. If no, then you are asked if you
would like to refer to RealNetworks’ Full Screen and DirectDraw information
page.
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To increase the image area to double size:

1. Click the  button.

2. Select the Double Size option from the menu.

To return to original size from double size:

1. Click the  button.

2. Select the Original Size option.

Note: If you are running RealPlayer with Windows 3.1 or Macintosh, simply

click the  button to double the image area. Click it again to return the
video clip to original size.

To increase the image area for video clips to full screen (Windows 95 and NT
only):

1. Click the  button.

2. Select the Full Screen option from the menu. The image will cover your
screen entirely. Click anywhere on the screen to return to original size.
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Setting a Preset Button

Preset buttons allow you to quickly jump to a RealMedia Internet address,
much like the buttons on a radio jump to preset radio stations.

To set a Preset Button to the clip currently being played:

1. In the RealPlayer window, right-click the Preset button you want to set to
the current clip and select Set Preset to (current clip).

2. Type in a Preset Label for the Preset button and click OK.

To set a Preset button manually:

1. Choose the Preferences option from the View menu.

2. Choose the Presets tab.

3. Type in the full URL (Internet address) of the site for the Preset button.

4. You can also enter text for the Label of the Preset button.

To clear a Preset button:

• In the RealPlayer window, right-click the Preset button you want to clear
and select Clear Preset.

To edit a Preset button:

• In the RealPlayer window, right-click the Preset button you want to edit
and select Edit Preset Button.  Type in any text changes to the URL or
Label.

Selecting a Preset Button

To select a Preset button:

• Click the appropriate Preset button. RealPlayer Plus connects to the
corresponding site and begins playing the clip.

To view other rows of Preset buttons:

• Click the up or down arrow next to the rows of presets to cycle through the
preset rows.



USING REALPLAYER PLUS

35

Scanning RealMedia Content

The Scan feature allows you to sample RealMedia stations, similar to scanning
stations on a radio. It plays each station for the amount of time specified on the
Presets tab of the Preferences window and then continues to the next station.

To begin scanning stations:

• To scan a variety of available stations: click the  button. RealPlayer
Plus scans and plays the next station. It plays the station for the amount of
time specified on the Presets tab of the Preferences window and then
continues to the next station.

• To select a category of stations: right-click (Windows) or click and hold
(Macintosh) the  button. A pop-up menu appears, where you can
select the category (for example: news, music, sports, international) or you
can select to scan your Preset buttons. RealPlayer Plus scans for the next
station that matches the category you selected.

To stop scanning when you find a station you like:

• Click the  button again.

To set a Preset button to the station currently being played:

• Right-click (Windows) or click and hold (Macintosh) on the Preset button
you want to set to the current station and select Set Preset.

To return to a previous station:

• Select Previous Clip from the Clip menu or press PAGE UP (on Windows)
/ CMD-1 (on Macintosh).

To skip to the next station:

• Select Next Clip from the Clip menu or press PAGE DOWN (on Windows) /
CMD-2 (on Macintosh).

To stop scanning and stop listening to the current station:

• Click the  button.
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Setting Your Destination Buttons

Your RealPlayer Plus comes with six buttons that you can customize to access
premium content with a push of a button.

To customize the Destination buttons:

• Click one of the buttons. RealPlayer Plus opens your default browser to
the Customize Destination Buttons page where you can select specific
content that you like. The buttons on your Player will then provide access
to that content. Follow the directions on that web page.

To play Destination buttons content:

• Click the appropriate button. RealPlayer Plus plays the associated file.
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Setting Preferences

You can customize RealPlayer Plus by changing the settings in the Preferences
window (opened from the View menu). The Preferences control various
aspects of RealPlayer applications functionality such as the number of clips to
remember, network information, and proxy information. These preferences
apply to all applications using RealPlayer technology.

Note: Macintosh preferences look slightly different, but the categories are
the same.



REALPLAYER PLUS GETTING STARTED GUIDE

38

General Preferences

The General tab in the Preferences window contains preferences for the
number of clips saved on the Open Recent menu, Synchronized Multimedia
support, and PerfectPlay mode.

Figure 10: General tab in the Preferences window
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Field Description

Recent Clips You can quickly replay clips by clicking Open
Recent under the File menu. This setting controls
how many clips are displayed in Open Recent.

Synchronized Multimedia Some RealMedia clips contain synchronized
multimedia events that display pages or images
in your Web browser. This setting controls
whether RealPlayer applications enable these
events.

PerfectPlay/BufferedPlay RealPlayer Plus allows playback of higher
quality clips on lower bandwidth connections
with the PerfectPlay feature. This setting
controls how much of the clip is buffered before
beginning playback.



REALPLAYER PLUS GETTING STARTED GUIDE

40

Connection Preferences

The Connection tab in the Preferences window contains information about
your bandwidth, statistics, and network timeout.

Figure 11: Connection tab in the Preferences window



SETTING PREFERENCES

41

Field Description

Bandwidth RealPlayer Plus automatically selects which
content can be delivered in real-time over your
connection. This setting controls the bandwidth
of the content selected.

Statistics RealPlayer Plus maintains statistics on
connection quality. These statistics help content
providers improve the quality of their service.
This setting controls whether statistics are sent to
the content provider.

Note: RealPlayer Plus does not send the content
provider any information about your identity
(such as your name or e-mail address).

Network Timeout These settings control how long RealPlayer Plus
waits to receive data before considering a
network connection to have failed. Increase the
values if you frequently receive timeout errors.

Connection Timeout: This is the amount of time
RealPlayer Plus will try a particular transport
protocol.

Server Timeout: This is the amount of time
RealPlayer Plus will try to connect to a server.
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Transport Preferences

The Transport tab in the Preferences window allows you to customize your
network connection for RealPlayer Plus. These preferences are for users behind
a corporate firewall. Most likely, if you are connecting to the Internet through
a commercial Internet Service Provider (such as AOL or MSN), you do not
have to set any of these preferences.

The Transport preferences assume a basic knowledge of Internet protocols and
firewalls. For more information about firewalls, refer to our World Wide Web
site at http://www.real.com/help/firewall/index.html.

Figure 12: Transport tab in the Preferences window
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Field Description

Network Transport RealMedia clips can be transmitted to your
computer through several different network
transport protocols. This setting controls how
these network transport protocols are selected.

Automatically select
most efficient transport

Use this setting if you are not aware of any
problems that require you to specify a transport
method.

Click the Auto Configure button to have
RealPlayer Plus automatically configure itself to
use the most efficient mode of transport for your
connection.

Use specified transports Use this setting if your computer has problems
using some network transports. Consult your
network administrator for the appropriate setting.

Click the Specify Transports button to access
the Specify Transport Settings window.

UDP Port Some networks have limited ports available for
Internet applications. This setting controls which
port RealPlayer applications use for receiving
data. Consult your network administrator for the
appropriate setting.

Note: This setting does not affect TCP packets
that can be received only through Port 7070.
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Specify Transports Window

The Specify Transports window allows you to select the different modes of
network transports that you can receive. Consult your network administrator
for the appropriate setting.

Figure 13: Specify Transports window

Field Description

Use TCP to Connect to
Server

Select this option if you want RealPlayer Plus to
use TCP for the initial connection to RealServer.

Attempt to use
Multicast for live
content

Select this option if you want RealPlayer Plus to
attempt to receive live content through multicast.

If you select this option, indicate how many
milliseconds the Player should attempt to use
this type of transport before switching to UDP.
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Field Description

Attempt to use UDP for
static content and for
live content not
available via Multicast

Select this option if you want RealPlayer Plus to
attempt to use UDP for static content and live
content not available through multicast.

If you select this option, indicate how many
milliseconds the Player should attempt to use
this type of transport before switching to TCP.

Attempt to use TCP for
all content

Select this option if you want RealPlayer Plus to
use TCP for all content.

Use HTTP Only Select this option if you are behind a firewall and
cannot receive data through TCP. All data will
be streamed through HTTP.

Note: You may not be able to receive some
content if you select this option.
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Proxy Preferences

A proxy is a server that acts as an intermediary between a company’s protected
LAN and the Internet. The proxy server ensures that all data transmission
between the Internet and a user on the LAN is authorized. RealPlayer Plus can
be configured to work with proxy servers by setting the proxy preferences.

During the RealPlayer Plus installation, the Setup program looks for HTTP
proxy information in your browser’s preferences. If it finds proxy information,
it displays this window with the information it found. You can verify that it is
correct or modify it as necessary.

Note: For more information about proxies and firewalls, refer to our World
Wide Web site at http://www.real.com/help/firewall/index.html.

Figure 14: Proxy tab in the Preferences window
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Field Description

Use Proxy Click this box if RealPlayer Plus should connect
to the Server using a proxy; a check mark
appears in the field. Otherwise, do not click this
box.

Note: If you are behind a firewall and do not
know the host name or port number of your
proxy server, ask your system administrator.

RealPlayer Proxy Enter the domain name or IP address of the
RealPlayer Plus proxy server and port number
that RealPlayer Plus should use to communicate
with the proxy server.

Note: For information on RealPlayer Proxy, read
http://www.real.com/help/firewall/index.html

HTTP Proxy Enter the domain name or IP address of the
HTTP proxy server and port number that
RealPlayer Plus should use to communicate with
the proxy server. Check your World Wide Web
browser’s proxy configuration.

No Proxy for: [Host1,
Host2…]

If you have specified that RealPlayer Plus should
be connected to the Server using a proxy, you
can specify certain servers that are inside your
corporate firewall (domain names or IP
addresses) with which you do not need to
communicate using the proxy server. Enter these
hosts in this field. This field is available only if
you have enabled the Use Proxy option.

Your system administrator can provide you with
this information, if appropriate.
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Advanced Preferences

Options on the Advanced tab of the Preferences window override RealPlayer
defaults for sound card compatibility, for CPU and memory requirements, for
Zoom specifications, and for system tray use.

Note: RealPlayer Plus for Windows 3.1 does not have a Zoom specifications
option or System Tray option.  RealPlayer Plus for Macintosh does not have a
System Tray option or Sound Card Compatibility option.

Figure 15: Advanced tab in the Preferences window
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Field Description

Audio Playback
Performance

RealPlayer applications use this setting to
optimize the performance of clip playback.
Change this performance setting only if your
computer seems sluggish or has problems while
playing some audio content.

Sound Card
Compatibility
(Windows only)

Modify sound card settings to overcome audio
problems.

Disable 16-bit sound
(use 8-bit only)

Use this setting if you have an older sound card
and clips sound scratchy or distorted.

Disable custom
sampling rates

Use this setting if clips play at the wrong speed
or sound scratchy or distorted. (Requires a
floating point coprocessor.)

Zoom
(not available in
Windows 3.1)

Click the Zoom button to open a window where
you can select Zoom specifications.

Refer to Figure 16 for an example of the Zoom
window.

System Tray
(Windows 95 and
NT only)

Select this option if you want RealPlayer Plus to
stay resident on your system, creating an icon in
your system tray. With this option selected, you
will be able to quickly access RealPlayer Plus.

By default, this option is selected.
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Figure 16: Zoom window

Field Description

Allow content providers
to specify zoom mode.

Content providers can specify a Zoom mode,
causing the Player to zoom to a larger size
automatically. Select this option if you want
content providers to specify zoom mode.

By default, this option is selected.

Never prompt when
content will not fit on
screen.

When a clip will not fit on your screen,
RealPlayer will ask if you want to automatically
resize your window. Select this option if you
don’t want RealPlayer to prompt you when
content will not fit on your screen using the
current settings.

For more information, refer to “Changing the
Size of the RealPlayer Window” on page 30, and
Figure 9, “Change Current Settings Window,” on
page 31.
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Language Preferences

The setting on the Language tab of the Preferences window determines the
language used within RealPlayer Plus.

Note: RealPlayer Plus for the Macintosh does not have a Language Preferences
option.

Figure 17: Language tab in the Preferences window
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Field Description

Current Language This field displays the language being used
within RealPlayer Plus.

Installed Languages Select the language you want to use within
RealPlayer Plus.

Note: Please contact RealNetworks regarding
information on languages available for
RealPlayer Plus.
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Upgrade Preferences

The setting on the Upgrade tab of the Preferences window determines if the
RealPlayer Plus checks for the availability of newer version of the Player.

Figure 18: Upgrade tab in the Preferences window
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Field Description

Upgrade Notification RealPlayer Plus periodically contacts the
RealNetworks Web site to determine if a newer
version is available. When a newer version is
available, RealPlayer Plus alerts you and
provides a link to a Web site where you can
download the new version.

If you do not want RealPlayer Plus to check for
upgrades, check the Disable Automatic
Upgrade Notification button.

Check for Upgrade
Availability

Click this button to check for any available
RealPlayer Plus upgrades.
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Presets Preferences

Using the Presets tab of the Preferences window, you can modify the label of
the Preset buttons and the URL corresponding to that Preset button. You can
also set the length of time each clip is played when you scan.

Figure 19: Presets tab in the Preferences window
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Field Description

Label Enter the text you want to appear as the label of
this Preset button.

URL Enter the URL (Internet address) you want to
play when this Preset button is clicked. You must
enter the full URL. For example:
http://presets.real.com/plus/pop1.ram

Scan Time This setting controls how long RealPlayer Plus
plays each clip as it scans.
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Troubleshooting

The following are some common questions about RealPlayer Plus and
recommended solutions.

Player Plus specific information, a technical knowledge base, frequently asked
questions list, and technical library are available from the PlusZone at:

http://pluszone.real.com/

For the latest information on RealMedia products, visit the RealNetworks
home page at:

http://www.real.com

Please refer to the enclosed Technical Support Card for more information on
contacting RealNetworks Technical Support.

I installed Internet Explorer after installing RealPlayer Plus
and lost my RealPlayer Plus. What do I do?

Microsoft Internet Explorer installs the RealAudio Player during its
installation. This may overwrite your RealPlayer Plus. If this occurs, you need
to re-install RealPlayer Plus after installing Internet Explorer.

How do I get Full Screen to work?

The Full Screen option is available for Windows 95 and Windows NT users
only. If you are using one of these operating systems and still have problems
with Full Screen (e.g. only a black screen appears), make sure that you have
the following installed on your machine:

• Microsoft DirectX Tools with DirectDraw
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You can download the most recent version and installation instructions
from RealNetworks’ DirectDraw support page
(http://service.real.com/fullscreen/default.html). When you install
DirectX, you must choose to upgrade your video drivers. You may lose
old functionality of your drivers, however.

• Updated video drivers

You can find these either from the company that manufactured your video
card or from RealNetworks’ DirectDraw support page
(http://service.real.com/fullscreen/default.html). If you update your video
drivers, you may lose old functionality of your drivers.

Why doesn’t my RealPlayer Plus have a Volume Control
slider?

If the sound card installed in your computer does not support volume control,
the Volume Control slider does not appear on RealPlayer Plus.

How do I configure my browser to support RealMedia files?

With most browsers, RealPlayer Plus installation configures the browser. If
you change your browser and it stops recognizing RealMedia files, reinstall
RealPlayer Plus. To manually configure your World Wide Web browser, refer
to the following page:

http://service.real.com/help/faq/index.html

Why can’t I record from some sites?

Content providers control whether or not you may record a clip. If you attempt
to record a clip that has this feature disabled, the  icon appears in the
Status Bar of RealPlayer Plus.
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Why can’t I play clips on my computer at work?

If you’re on a local area network which is attached to the Internet, and are
unable to play RealMedia files from remote Web sites, it’s possible that your
company’s firewall is preventing the stream from reaching you. Users can
receive live and on-demand clips from the Internet without exposing their
company’s network to security risks.

If your computer is behind a firewall, please see RealNetworks’ firewall page
for more information: http://www.real.com/help/firewall/index.html

What’s wrong when the playback is poor?

The expected playback quality will vary depending on bandwidth and the
encoding algorithm you are playing. If the quality is garbled, choppy, or skips,
use the following to isolate and correct the problem.

If the sound quality was poor when the Thankyou.rm file played at the end of
the RealPlayer Plus installation, you may have a sound card conflict. Try
changing the settings on the Advanced tab in the Preferences window. Refer to
“Advanced Preferences” on page 48.

If the playback quality was good when the Thankyou.rm file played at the end
of the RealPlayer Plus installation, but is poor at a particular site, use the
Connection Statistics window in RealPlayer Plus (select Statistics from the
View menu) to check for lost packets. If the packet loss is high, it may be due
to a busy network. Select PerfectPlay Mode from the File menu or connect to
the site at a later time.

If the playback quality was good when the Thankyou.rm file played at the end
of the RealPlayer Plus installation, but is poor at all sites, complete the
following steps.

If the playback quality is poor on every site, do the following:

1. Check the actual modem connection speed. This may be shown in the
lighted display for external modems, or through an information window if
you have an internal modem (check the user manual for your modem).
Sometimes service providers use a lower rate connection speed such as
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14.4 Kbps, so even though you are dialing in on a 28.8 Kbps modem, you
are only receiving data at 14.4 Kbps.

2. Contact RealNetworks’ Technical Support by calling the support number
on your Technical Support Card or sending e-mail using the form on
http://service.real.com.
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